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3 Lasernet Meta 10 

1 Introduction. 

 

This guide is written for everyone who works with Lasernet   
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2 Terms of Use. 

No part of this publication may be reproduced, transmitted, transcribed, or translated into any language in 

any form by any means without the prior written permission of Formpipe Software. The information in this 

manual is subject to change without notice. Any company names or data is fictive unless otherwise stated. 

Formpipe Software shall not be liable for any loss or damage whatsoever arising from the use of this manual 

and the information contained therein (including errors or omissions). 

Trademarks of other companies mentioned in this document appear for identification purposes only and are 

the property of their respective companies. 

© 2023 Formpipe Software. 
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3 Lasernet Meta. 

 

Lasernet includes a Meta module, which gives the ability to create custom solutions which can interact via 

web services in Lasernet Server.  

From Lasernet Meta, running on client site, you will be able to exchange your documents together with 

metadata and send them via queues defined in the Lasernet Server, to any destination supported by 

Lasernet.  

You can send documents to the Lasernet Meta client via a Windows printer or a file folder. Printed 

documents, in the formats Postscript/PCL (requires 3rd party conversion tools) and Lasernet EMF, will be 

converted to PDF on the fly before they are transferred to the Lasernet server. 

You must validate that Lasernet Meta and Lasernet Server version are in sync. Lasernet Meta always 

requires that it is connected to Lasernet Server running the same version. 

 

To allow Lasernet Meta to connect to Lasernet Server, a Meta Input Queue must be running. Configure the 

queues type in the Meta Input properties. 

3.2.1 Queues 

In the Queue tab you can add and administer a list of queues that will be available for the users running the 

Lasernet Meta application. For each queue you can add a list of fields by using the toolbox. Each field, 

depending on type, can have a set of properties. 
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 Add a new queue 

In the above screen shot we have already added five queues with icons and a list of Meta fields. 

Click the Add button in the Queues tab section to add a new queue. 

 General tab 

Type in a queue name and select one of the pre-defined icons from the icon list or you can click the browse 

button to select one of your own icons from a folder. Recommended icon format is 64 px. Other formats will 

automatically scale to fit the required icon size. 
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 Conversion – server-side 

In the Conversion tab you define parameters for converting PostScript to PDF on the server-side. 

 

The Meta Input module has support for running an executable file from a command line. A tool like 

GhostScript is recommended for converting PostScript to PDF and can be used as a third-party converter. 

Formpipe Software does not sell or support GhostScript and the software must be downloaded, installed and 

maintained by the end-user. 

Example of running GhostScript 9.16 from a command line:  

"C:\Program Files\gs\gs9.16\bin\gswin64c.exe" -q -P- -dSAFER -dNOPAUSE -dBATCH -sDEVICE#pdfwrite -

sOutputFile#%2 -dCompatibilityLevel#1.4 -c .setpdfwrite -f%1 

You can set up different conversion parameters for each queue if required (see GhostScript documentation 

for more information about supported parameters). The parameters defined on a queue and will have higher 

priority than defined in the general settings for the module. 

Note: The conversion parameters can also be defined and is recommended to run in the Lasernet Meta 

application on client site and then leave the conversion settings in the Meta Input module empty. This way 

you can convert the documents locally instead of at server side. The Lasernet Meta application is bundled 

with a PDF converter, which can convert EMF to PDF. When using the converter bundled with the Lasernet 
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Meta application there are no requirements for installing and running third party tools for converting 

documents into PDF. 

 Properties 

A range of parameters can be defined for each queue. The properties are used to specify the name and icon 

of the queue, allow attachments, specific document types, preview options and converter settings on the 

server-side.  

Allow attachment Enable attachments for queue. The user will be able to attach 

additional files to the primary job. 

Allow Autofill Autofill functionally has been configured for queue. The Autofill 

function requires that PDF data can be converted to a text 

format and automatically recognize the field data. The Lasernet 

Input Management solution is recommended to be used for 

auto filling of fields. 

Extensions List of allowed attachment extensions, like .pdf, .docx etc. 

Click … button to open the String Collection Editor. Insert the 

strings in the collection (one per line). Empty list (default) 

means any extension is allowed. 

Icon Click … button to pick up an icon for the queue from a folder. 

Recommended icon format is 64 px. Other formats will 

automatically scale to fit the required icon size. If you double 

click on the queue, in the left window, you can also select one 

of the predefined icons. 

Name Name of queue. 

Preview Queue can be used for preview only. 

PS2PDF Optional conversions settings for converting PostScript to PDF 

via a shell command. 

Server-side Print data will be converted on server-side. 

3.2.2 Fields 
Select a queue for which you want to design a list of fields. The fields with values are used for adding Meta 

data to the incoming job. The toolbox includes the following tools: Header, Checkbox, TextBox, 

NumericUpDown, ComboBox, MemoBox, File and Separator. 
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Drag and drop the tools from the toolbox to the selected queue window in the order you want them to appear 

in the Lasernet Meta application. You can order or remove them afterwards with the Move Up, Move Down 

and Remove buttons. 

The tools are used for customizing the fields and the properties in the Lasernet Meta application. 

Header A label text for a section of meta fields. 

Label The text associated with the field. 

Name Name of Field. 

Tooltip Optional tool tip for header. 

 

CheckBox A square box that can contain white space (False) or a tick 

mark (True). 

Checked Optional default check state. 

Label The text associated with the field. 

Name Name of Field. 

Read only Field cannot be edited by user. Possible 
values are False (default) and True. 

Remember 
value 

Remember last used value. Possible 
values are False (default) and True. 

Text Optional default text. 

Tooltip Optional tool tip for checkbox. 

 

TextBox A single-line text box that can contain a string with default 256 

characters. 

Label The text associated with the field. 
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Name Name of Field. 

Read only Field cannot be edited by user. Possible 
values are False (default) and True. 

Remember 
value 

Remember last used value. Possible 
values are False (default) and True. 

Text Optional default text. 

Tooltip Optional tool tip for text field. 

Validation Optional rules for validating contents of 
field. Click … button to open the 
Validation dialog. Regular Expressions 
and JavaScript are supported for setting 
up validation rules. 

 

NumericUpDown A control that represents a numeric textbox that can be 

increased or decreased in value. 

Decimal 
places 

Indicates the number of decimal places to 
display. 

Increment Indicates the amount to increment or 
decrement on each button click. 

Label The text associated with the field. 

Maximum Indicates the maximum value for the 
numeric up-down control. 

Minimum Indicates the minimum value for the 
numeric up-down control. 

Name Name of the Field. 

Read only Field cannot be edited by user. Possible 
values are False (default) and True. 

Remember 
value 

Remember last used value. Possible 
values are False (default) and True. 

Thousands 
separator 

Indicates whether the thousands 
separator will be inserted or not. 

Tooltip Optional tool tip for field. 

Value Optional default value of the numeric up-
down control. 

Width Width of control. Default is 0 pixels (full 
width). 
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ComboBox A drop-down list and a single-line editable textbox, allowing the 

user to either type a value directly or select a value from the 

list. 

CSV File Path and filename to CSV file in the 
format 

“Header1”,“Header2,“Header3” 

“Value1,”Value2”,”Value3” 

“Value1,”Value2”,”Value3” 

The list of records, added to the CSV file, 
will be included in the drop-down list. The 
value of the first column can be selected 
and used as value for the field. Other 
columns are for viewing purposes only. 

Header names: Required 

Field separator: Comma only 

Quotes: Not required but recommended 

Number of columns: A maximum of 6 
columns are recommended for viewing 
purposes. 

Note: Lasernet Meta must be restarted to 
load an updated CSV file 

If the CSV file contain a parsing error, 
because of incorrect CSV format, a dialog 
will pop-up in the Lasernet Meta 
application with a warning “Error parsing 
CSV file” and the line number.  

The Count value shows the total number 
of successfully imported records in the 
grid. 

 

It must be reported to the creator of the 
CSV file if there is a mismatch between 
Index number and Count. 
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Editable Allow users to enter a value which is not 
in the drop-down list. 

Items List of strings in the drop down. Click … 
button to open the String Collection 
Editor. Enter the strings in the collection 
(one per line). 

Label The text associated with the field. 

Name Name of Field. 

Read only Field cannot be edited by user. Possible 
values are False (default) and True. 

Remember 
value 

Remember last used value. Possible 
values are False (default) and True. 

Text Optional default text. 

Tooltip Optional tool tip for combo box. 

Validation Optional rules for validating contents of 
field. Click … button to open the 
Validation dialog. Regular Expressions 
and JavaScript are supported for setting 
up validation rules. 

Value Optional default value. 

 

Memobox A multi-line text box that can contain a string with default 1024 

characters. 

Height Minimum memo height in pixels. Default 
value is 20 pixels (single line). 

Label The text associated with the field. 

Name Name of Field. 

Read only Field cannot be edited by user. Possible 
values are False (default) and True. 

Remember 
value 

Remember last used value. Possible 
values are False (default) and True. 

Tooltip Optional tool tip for memo box. 

Validation Optional rules for validating contents of 
field. Click … button to open the 
Validation dialog. Regular Expressions 
and JavaScript are supported for setting 
up validation rules. 
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Value Optional default value. 

 

File A field to include a text or binary file added from a disk drive. 

The file field can as example contain a list, in a CSV or XLSX 

format, that is used by the Lasernet server to send the same 

job to multiple receivers.  

Extension Optional list of allowed file extensions. 

Label The text associated with the field. 

Name Name of Field. 

Read only Field cannot be edited by user. Possible 
values are False (default) and True. 

Remember 
value 

Remember last used value. Possible 
values are False (default) and True. 

Tooltip Optional tool tip for file field. 

Validation Optional rules for validating contents of 
field. Click … button to open the 
Validation dialog. Regular Expressions 
and JavaScript are supported for setting 
up validation rules. 

Value Optional default value. 

 

Separator A graphical line to visually separate fields. Cannot contain 

data. 

Name Name of Field. 

Type Type of field. Separator is the only valid 
value. 

 

 

The queues defined in the Meta Input module can be added to the Lasernet Meta application one by one. 

Different users can have different queues with different Meta fields. 
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3.2.3 Validation 
The Validation property can be used to validate the contents of a Meta field in the Lasernet Meta 

application. Meta fields not matching specified conditions will be marked with a red cross when the Send 

button is clicked and the job will not be released, before all fields are successful validated 

 

 Validate via regular expression 

 

In this example we have created a regular expression matching a number in the US format with comma as 

thousand delimiters and dot as comma delimiter. 
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Regular Expression: ^[0-9]{1,3}(,[0-9]{3})*(\.[0-9]{2})?$ 

The $ sign at the end of the regular expression is essential to match the full string and not a part of the string. 

The Parameter field and Test button are useful to validate the expected result of the regular expression. 

This functionality is for online testing only in the Lasernet Developer. 

 

For more information regarding syntax regular expression, we recommend to search the Internet. 

 Validate via JavaScript 

 

In this example we have created a JavaScript matching that the parameter is not empty and activated that an 

error result is marked as unsuccessful (red errors). 

 

In this example we have created a JavaScript matching that the parameter is higher than a specific amount 

and activated that an error result is marked as tentative (yellow errors). The parameter string is essential 
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and contains the contents of the JobInfo to be validated. The expression will return empty string when 

validation of parameter is successful and error text when it fails validation.  

if (parameter > 50000) 

return "Amounts > 50.000 must be validated"; 

else 

  return ""; 

The Parameter field and Test button are useful to validate the expected result of the JavaScript. This 

functionality is for online testing only in the Lasernet Developer. 

 

 

3.2.4 Populating Meta Queues to Lasernet Server 
When the queue(s) have been added to the Meta Input module you can click Update in the Lasernet 

Developer to populate the web services in the Lasernet Server. The Lasernet Meta application can now be 

installed on the clients and connect to the queues. 
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An installation package for Lasernet Meta can be found in the Lasernet installation folder in a sub folder 

named “Clients” or downloaded separately from the Lasernet by Formpipe support site. 

Run the Lasernet Meta MSI installation package with the required rights to install software on your client. 

Follow the instructions in the installer software. 

When Lasernet Meta is installed, the application will run in the tray bar and ready to be configured. 

 

3.3.1 Connect client to server 
First you have to establish a connection between the Lasernet Meta client and the Lasernet Server to be 

able to retrieve information about available Meta queues. 

 

3.3.2 Connection 
 

Server 

Name of the Lasernet Server instance to connect to. The instance name must exist on the Lasernet Config 

Server. Click the drop down box to select an existing service instance. 

3.3.3 Conversion – client-side 
In the Conversion tab you must define parameters for converting, PostScript to PDF, EMF to PDF and PCL 

to PDF, on client-side. 
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The Meta Input module has support for running an executable file from a command line. 

For each Meta queue you can set up a PDF converter with different parameters. The conversion parameters 

can be defined either in the general option settings or in the Meta queue settings. The parameters defined on 

queue level will have higher priority than the general settings. 

PS (PostScript): 

GhostScript is an effective PostScript to PDF converter and can be used as third-party converter. Formpipe 

Software does not sell or support GhostScript and the software must be downloaded, installed and 

maintained by the end-user. 

Example of running GhostScript 9.16 from a command line in the Conversion tab:  

"C:\Program Files\gs\gs9.16\bin\gswin64c.exe" -q -P- -dSAFER -dNOPAUSE -dBATCH -sDEVICE#pdfwrite -

sOutputFile#%2 -dCompatibilityLevel#1.4 -c .setpdfwrite -f%1 

Read the GhostScript documentation for more information about supported parameters. 

Printer driver: A type 3 PostScript driver must be installed and selected for Meta printer queues for 

successfully converting PostScript to PDF via GhostScript. If Lasernet Meta detects PostScript as the 

incoming print format the converter in the PS section will be executed. 

EMF: 

The Lasernet Meta application is bundled with an EMF to PDF converter. This converter is developed and 

maintained by Formpipe Software. In most scenarios we recommend this format, but be aware of that the 

Windows EMF format is more memory consuming than PostScript and has limited support for handling font 

families, ligatures (see parameter for font embedding) and glyphs. 

Example of running LnPDF from a command line in the Conversion tab: 

LnPDF.exe -i "%1" -o "%2" -pdfa -multi-language -embed-fonts 

The EMF to PDF converter supports the following parameters: 
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lnpdf Name of executable. 

-i “%1” Defines the input parameter (EMF). 

-o “%2” Defines the output parameter (PDF). 

-r Name of reference printer is optional. If the parameter is not 

added or the printer name does not exist the meta printer 

queue is used as reference printer. You can set a dedicated 

Windows printer queue as reference printer, to convert EMF to 

PDF, if the converted PDF document does not look as 

expected. 

-pdfa (optional) PDF/A is a PDF format typically used for the long-term 

archiving of electronic documents and is based on the PDF 

reference version 1.4. Fonts and color profiles will be 

embedded in the PDF file. The PDFA parameter will increase 

the PDF file size. 

-multi-language 

(optional) 

By default, the PDF format includes 7-bit ASCII characters 

only. Multi language support must be activated for supporting 

and embedding additional characters and fonts. The multi-

language parameter will increase the PDF file size. 

-embed-fonts (optional) Determines what fonts are embedded in the PDF file. Font 

embedding is used to assure correct output on other client 

computers. For supporting ligatures in printed documents, this 

parameter must be activated. The font embedding parameter 

will increase the PDF file size. 

A Lasernet EMF printer driver must be selected for Meta printer queues to convert EMF to PDF with the 

bundled LnPDF converter. The printer driver is automatically installed by the Lasernet Meta installer. When 

Lasernet Meta detects EMF as print format the converter defined in the EMF section will be used. 

PCL: 

Lasernet Meta is able to detect PCL as incoming print format. You must install a type 3 PCL printer driver 

and install and configure an external PCL to PDF converter to successfully convert PCL into PDF. You can 

setup the command line and required parameters in this section. 

3.3.4 Misc settings 
The Misc settings contain various settings for connectivity and preview of documents. 

Proxy port 

A proxy port number is required to print documents from a Windows application to Lasernet Meta. Type in a 

port number that does not conflict with other ports running on the computer. If you have installed Lasernet 

Server on the same computer as Lasernet Meta, it is recommended not to use port 3279 for Lasernet Meta, 

since this is the default port used by the Lasernet Server. 

Lasernet Meta has dependencies to the Lasernet Meta Proxy 10 service. The printed documents are 

processed via this service and distributed to the local Windows user running the Lasernet Meta application.  
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Ensure that this service is always in “Running” status or the print job will fail in the Windows printer queue. 

 

Prompt user  

If you always want to prompt user for confirmation when deleting or sending job you can activate this setting. 

Print job is too large 

To prevent that the application runs out of memory, because the print document contains too many pages 

and images in a high resolution, a registry setting can overrule the default maximum value of 512 mb. 

const LnRegKey regkey = AppHelp::openMachineRegistrySettings(L"Meta\\Settings\\Proxy", 
LnRegKey::accessRead); 
 
const int maxprintsize = regkey.getValueInt(L"MaxPrintSize", 512 * 1024 * 1024); 

 

[HKEY_LOCAL_MACHINE\SOFTWARE\Formpipe Software\Lasernet 10\Meta\Meta\Settings\Proxy] 

"MaxPrintSize"="512" 

 

If the job exceeds the maximum value a warning will appear in the preview window and the job is cancelled 

by the application. 
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3.3.5 Queue - Settings 
To setup a queue you also have to connect to server on queue level, since each queue can have individual 

credentials. 

 

Right-click in the Queue section, in the left border of the application, to Add a Queue and configure the 

Queue settings. 
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Module 

Name of Meta Input module to connect to. Click Test button to retrieve the list of available queues for the 

selected module. A dialog should pop up showing number of available queues for the selected module. 

Queue 

Select a Queue from the drop down list. 

 

When the settings are accepted the queue will be added to your Lasernet Meta application. 

 

A Windows printer queue will automatically be added to the list of printers in Windows. The printer queue is 

the connection between your Windows application and the Lasernet Meta application.  

 

The printer queue will be configured with the following default printer properties. 

Printer Driver: Lasernet EMF 

Printer Port: Lasernet Printer Port 
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Print Processor: Lasernet Print Processor 

 

The Printer Port, assigned to the Lasernet Printer Queue, will automatically be set to the port number defined 

in the Options → Misc → Print port settings. 

Maintaining Queues 

When a Queue has been added you are able to Add, Edit or Remove Queues. Right click in the area listing 

the Meta queues. 

 

3.3.6 Queue – Poll Folder 
As an alternative to print documents to Lasernet Meta you can define a polling folder for incoming files. 

Printing and polling are supported to run simultaneously. 

Click the Browse button to select a local folder to scan for incoming documents. 
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The application will scan for documents in the folder for files with the extensions that are allowed for the 

queue. Settings for allowed extension(s) are found in the properties of the Meta input queue(s) in the 

Lasernet configuration. 

 

3.3.7 Queue – Conversion 
Add a command line for conversion from PS, EMF or PCL to PDF or another output format. Command lines 

added on queue level will overwrite the command lines defined in the Tools → Options → Conversion 

settings. 



 

25 Lasernet Meta 10 

 

More information about valid conversion parameters are available in the chapter “Conversion – client-side”. 

3.3.8 Queue – Afterburner 
Insert a command line to parse the output file with a 3rd party tool before transferring data to the Lasernet 

Server. 

 

An example is to run an application, which is able to sign the document with a user certificate, before data is 

transferred to the Lasernet Server. 

 

Lasernet Meta provides an easy-to-use environment for converting, attaching and sending documents with 

Meta data to the Lasernet Server. 
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Lasernet Meta has three main areas. The Meta queues on the left, the Meta fields in the middle, and the 

preview on the right. The user interface is laid out as follows: 

Menu bar (1) 

In the Tools menu you configure the main options for the application. 

Queues (2) 

Right click in the Queue section to Add, Edit or Remove Meta queues. Click on a specific queue to view and 

administer available jobs, which are stored in the queue and ready to be send. You can always exit the 

application, with jobs stored in a queue, since jobs are stored temporary on disc. 

Create a new job (3) 

Click here if you manually want to add a new job to a queue with an extension allowed by the administrator 

(see Extensions property for Meta Input queue in the server settings). Before adding a job please first select 

a queue. 

Meta card (4) 

Card for typing in Meta values to be assigned to the job. A queue can contain up to 50 jobs and will 

afterwards be paused by system. When jobs are sent by user the queue will automatically be resumed and 

ready to receive new incoming jobs. 

Tool buttons (5) 

Four tool buttons are available in the bottom of each card. The Autofill button is only selectable if allowed by 

administrator (see Allow Autofill property for Meta Input queue in the server settings). 
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Attachment Click here if you want to add an attachment to the primary job 

with an extension allowed by the administrator (see Extensions 

property for Meta Input queue in the server settings).  

Autofill Autofill functionally has to be configured for the queue on the 

Lasernet Server. The Autofill function will, if possible, 

automatically insert Meta data retrieved from the job in to the 

Meta fields in the card. 

Delete Click here to delete the job from the queue. A warning will pop-

up where you have to accept to delete the job. 

Send Click here to send the job with Meta data to the Lasernet 

Server. A warning will pop-up where you have to accept to 

send the job to the Lasernet Server. 

 

Jobdata and Attachments (6) 

Right click here to Add or Remove the primary job or attachments with an extension allowed by the 

administrator. Removing jobs will not delete the Meta data added to the card. To delete both job, attachment 

and Meta data you must use the Delete button in the card. 

Preview (7) 

A preview of the job. A range of document formats can be previewed, like PDF, DOC, XLS, TXT and XML. 

Printed jobs will always be previewed as PDF, manually added jobs will be previewed in same format as 

received. File formats that cannot be previewed can also be sent with Meta data to the Lasernet Server if 

allowed by the administrator. 

 

You can print documents from most Windows applications to Lasernet Meta for adding jobs. In this chapter 

we will list the most common applications. 

3.5.1 Microsoft Word, Excel etc. 
From Microsoft Word you can use the print function to add the document in a Lasernet Meta Queue and 

convert it to PDF. Any of the queues added to your Lasernet Meta application, will be available as Windows 

print queue on your local computer, and prefixed with a Lasernet text to indicate that the print queue is 

connected to a Lasernet Meta application. 

 

Select File → Save as type: DOCX, XLSX or PDF if you want Microsoft Word or Excel to generate Word, 

Excel or PDF formats for Lasernet Meta. Use the polling feature in Meta queue to pick up the files or 

manually add them to a queue. Meta data can be added to documents before being sent to the Lasernet 

Server.  

3.5.2 Lasernet Meta Output module 
In the Lasernet Server you can configure the Meta Output module to send jobs to Lasernet Meta. You only 

have to define a host name, a port number and the name of the queue to send the job to. 
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Host Name of Windows client running Lasernet Meta. 

An IP address is not supported. 

Port The port number used between Lasernet Meta Output (server) 

and Lasernet Meta (client). 

Queue Name of Meta queue to send job to. 

Username Name of Windows user to retrieve document.  

 

All the fields have JobInfo substitution support. Type the name of a JobInfo, surrounded by hash marks like 

#NameOfHost#, and the value of the JobInfo will be substituted with the value of the JobInfo. 

 

3.5.3 Preview mode 
If you want Lasernet Meta to act as a preview tool and prevent the users to add Meta data and send jobs 

back to Lasernet Server in preview mode, you can set the Preview property to True in the Meta queue. 
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When a job has been sent from Lasernet Server to Lasernet Meta only the Close button will be enabled in 

the card. A Meta queue can contain more than one preview job. To remove a job in preview mode, click the 

Close (ALT+C) button. 

 

 Preview with Meta fields 

Add a list of Meta fields to the preview queue if you want the values of JobInfos to be viewed together with 

the document in Lasernet Meta 

 

The values of the JobInfos, returned from the Meta Output module, must be assigned to JobInfos names 

equal the names of the Meta fields. 

If they Meta field is not allowed to be edited by user in preview mode, you can set the flag Read Only to true, 

and the Meta fields will be read only when the document is previewed. 
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The software and Windows printer queues can be deployed in silent-mode to the workstations by an 

administrator. Usage of deployment tools and security rules in Windows are not a part of this guide. 

3.6.1 Step 1 – Install and configure Lasernet Meta manually 
To create the required settings for your deployment tool you must install and configure at least a single client 

of Lasernet Meta manually, with option and queue settings. 

The registry settings are as default stored in: 

[HKEY_CURRENT_USER\Software\Formpipe Software\Lasernet 8\767D1DB0-ED35-4b4d-90A3-

164DF31AF5FC\Meta] 

3.6.2 Step 2 – Export and Import settings 
Before you deploy the software to the clients you must export the option and queue settings for Lasernet 

Meta: 

1. Start regedit.exe, locate the previous listed registry sub path, right click and select Export the registry 

keys. 

2. During deployment you can store the registry keys for Lasernet Meta in [HKEY_CURRENT_USER], which 

is the default value, or you can edit the registry file to import the settings in to [HKEY_LOCAL_MACHINE], 

by replacing the sub paths from [HKEY_CURRENT_USER] to [HKEY_LOCAL_MACHINE]. 

Note: If the user do not have administrative right or is not allowed to read/write in 

[HKEY_LOCAL_MACHINE] an “Attempted to perform an unauthorized operation” warning will be listed in the 

status bar of application. 

 

To run the application with a standard user, you must set the permission for Users to Full Control for: 

[HKEY_LOCAL_MACHINE\Software\Formpipe Software\Lasernet 8\767D1DB0-ED35-4b4d-90A3-

164DF31AF5FC\Meta] 
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Any user running Lasernet Meta on the same computer will share the same options and values for queues 

imported to [HKEY_LOCAL_MACHINE]. 

3.6.3 Step 3 – Deployment 
You are now ready to deploy and import the registry settings for Lasernet Meta via your preferred 

deployment tool.  

1. Deploy the exported registry settings to the workstations with administrative rights via a login script. 

2. Set the permissions as described for [HKEY_LOCAL_MACHINE] or leave as is for 

[HKEY_CURRENT_USER] 

 

3. To install the software in silent mode run: 

msiexec /i "C:\[Folder]\Lasernet Meta 10.x Setup.msi" /quiet 

Note: To hide options and prevent the users to manually add new queues or edit existing settings in 

Lasernet Meta you can import/set an additional registry key/value in: 

[HKEY_LOCAL_MACHINE\SOFTWARE\Formpipe Software\Lasernet 10\Meta\Meta\Settings] 

"HideOptions"="True" 

 

The HideOptions setting is a string with value set to True in [HKEY_LOCAL_MACHINE].  

If options are not hidden, the user is able to manually add new Meta queues if the login credentials are 

known by the user. 

You can always run “LnMeta.exe -function PrintersSync” to synchronize Windows printers and Lasernet 

Meta queues. This option is already executed by the Lasernet Meta 10.x Setup MSI installer during 

installation. 

3.6.4 Registry location for manually added queues 
Queues manually added to Lasernet Meta will always be located in [HKEY_CURRENT_USER] and only 

accessible for the user who added the queue. Both queues stored in [HKEY_LOCAL_MACHINE] and 

[HKEY_CURRENT_USER] will be accessible for the user. 
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